


Curriculum Plan of Mathematics (Session: 2023-2024)

STD VII
Book prescribed: NCERT Mathematics

Reference Book-Composite Mathematics (S.K. Gupta)

Month Project/Activity Mental Written Work
Content/Theme Maths/Value
Based Questions

April » Class Activity » Topic wise » KeyTerms
Chapter 1 (Integers) 1. To show the addition worksheets » NCERT Textbook

» Number line and subtraction of » Class test Exercise

» Properties of addition and subtraction of integers integers. (stair case » Assignment

» Multiplication of integers activity)

» Properties of multiplication of integers 2. Sports activity on

» Division of integers integers.

» Properties of division of integers

Chapter 2 (Fractions and decimals)
» Multiplication of fractions
» Division of fractions
» Multiplication of decimal numbers
» Division of decimal numbers

Class Activity

To teach fraction using
coloured chalk and pizza.

> Worksheet

» KeyTerms

» NCERT Textbook
Exercise

» Assignment

June
Chapter 4 (Simple equations)
» Equation
» Solving an equation
Application of simple equations to practical situation

PERIODIC TEST -1

Sport Activity

» Worksheet on
word problems

Worksheet on

solving equation

» KeyTerms

» NCERT Textbook
Exercise

» Assignment




Month Project/Activity Mental Maths Written Work
Content/Theme
July » Chart on Types of angles and » Worksheet > Key Terms
Chapter 5 (Lines and angles) angles made by transversal lines. » NCERT Textbook
» Types of angles » To verify the linear pair and Exercise
» Pair of lines V.O.A property using real life > Assignment
» Angles made by transversal lines objects. » Flowchart
August » Lab Activity » Classtest& |» KeyTerms
Chapter 3 (Data Handling) e To represent the data on a Oral test on » NCERT Textbook
> Collection and organization of data bar graph and find the probability Exercise
> Representative values mean and range of the Assignment
> Arithmetic Mean and Range given data.
» Mode and Median e Activity on probability
> Use of Bar Graph using coin, dice, chalk,
> Probability paper, etc.
>
» Key Terms
Chapter13 (Exponents and powers) > Worksheet » NCERT Textbook
> Laws of exponents Exercise
Assignment

» Decimal number system
» Expressing large numbers in standard form

September : Revision

HALF YEARLY EXAMINATION




September o > Worksheet > Key Terms
Chapter 6 (Triangles and properties) > Lab activity > NCERT Textbook
> Medians of a Triangle  To prove that sum of angles of a Exercise
> Altitudes of a Triangle triangle is equal to 180° > Assignment
> Exterior angle property e To prove that an exterior angle is > Flowchart
> Angle sum property equal to the sum of the interior
» Two special triangles: Equilateral & Isosceles opposite angles
» Inequality property of a triangle e To verify Pythagoras theorem
> Pythagoras theorem
Month Content/Theme Project/Activity Mental Maths Written Work
October » Class activity » Worksheet > Key Terms
Chapter 7 (Congruence of triangles) Concept of congruence —using » NCERT Textbook
» Concept of Congruence real life object. Exercise
> Criteria for congruence of triangles (SSS, SAS,ASA, > Assignment

RHS)

Chapter 12 (Algebraic Expressions)

» Terms of an expression » Worksheet > Key Terms

» Like and unlike terms » NCERT Textbook

» Monomials, binomials & polynomials Exercise

» Addition and subtraction of algebraic Expression » Assignment

» Finding the value of an expression

» Formulae and rules

» Patterns
November » Key Terms
Chapter 9 (Rational numbers) » Lab Activity » Worksheet » NCERT Textbook

Rational numbers on a Number line To represent rational numbers on Exercise

YV VVYVYY

Rational numbers in standard form

Comparison of Rational Numbers

Rational numbers between two Rational numbers
Operations on Rational Numbers

number line.

» Assignment




Chapter 10 (Practical geometry)
» Construction of a line parallel to a given line
through a point not on the line
» Construction of triangles under different criteria: SSS,
SAS, ASARHS

» Worksheet

» Key Terms

» NCERT Textbook
Exercise

> Assignment

December
Chapter 8 (Comparing quantities)
Equivalent ratios
Percentage for comparing quantities
Conversion of fractional numbers
Decimals and ratios into Percentage and vice versa
Use of percentage
Profit or loss as a Percentage
Simple Interest
Chapter 14 (Symmetry)
» Lines of symmetry of regular polygon
» Rotational symmetry

VVVYVYVVYY

PERIODIC TEST -2

» Discussion on interest given by
different authorities.

> Lab Activity
To draw the lines of symmetry of
different shapes

» Worksheet

» HOTS question
discussion

» Tricks to
calculate %

> Worksheet

» Key Terms

» NCERT Textbook
Exercise

> Assignment

» Key Terms

» NCERT Textbook
Exercise

> Assignment

Month Content/Theme

Project/Activity

Mental Maths

Written Work

January

Chapter 11 (Perimeter and area)

Area of squares and rectangles
Area of parallelogram

Area of triangle

Area of circle

Applications of perimeter and area

YV VY

» Lab Activity

» Graphical Activity for Area and
Perimeter of Different plane figures

» To prove that area of parallelogram is
twice the area of triangle.

> Worksheet

» Key Terms

» NCERT Textbook
Exercise

» Assignment




Chapter 15 (Visualising solid shapes) » Key Terms

» Nets for building 3Dshapes > Lab Activity » NCERT Textbook
» Drawing solids on flat surface To draw the solids on a flat surface | > Worksheet Exercise
» Viewing different section of a solid » Assignment

» Observation of
different things in
the surrounding
and discussing
their various
views.

February REVISION FOR ANNUAL EXAMINATION

March ANNUAL EXAMINATION




Curriculum Plan of Science (Session: 2023-2024)

Book prescribed: NCERT Science

Chapter 4 Heat

e Measurement of

e Discussion of

Month Project/Activity Oral Work Written Work
Content/Theme

PERIODIC TEST 1

(CHAPTERS-1,2,4,5)

April Activity: e Oral Questions e KeyTerms
Chapter 1 Nutrition in Plants e Observe Stomata in leaves | e Discussion of e KeyQuestions
» Mode of nutrition in plants e Fungus on bread NCERT Book e Diagrams
> Photosynthesis - Food making process in plants e Importance of sunlight for INCERT e Assignment
> Other modes of nutrition in plants photosynthesis ExemplarExercise
» How nutrients are replenished in soil Video:

e Process of photosynthesis

June Activity:

Chapter 2 Nutrition in Animals . )I/Based on importance of _ o KeyTerms
> Different ways of taking food vitamins  OralQuestions * KeyQuestions
> Digestion in humans - The mouth and buccalCavity e Test for effect of saliva e Discussion ofNCERT |® Dlagrams
» The food pipe /oesophagus on starch Book /INCERT e Assignment
» The stomach Video: ExemplarExercise
» The small intestine o Digestion in humans
> Absorption in the smallintestine « Digestion in Amoeba
» Large intestine O .
> Diggstion in grass eating animals * Digestion In Ruminants
> Feeding and digestion inAmoeba

April Activity: e Oral questioning.

e KeyTerms




Hot andcold

Measuringtemperature

Reading athermometer
Laboratorythermometer

Transfer ofheat

Kinds of clothes we wear in summerand winter
Woolen clothes keep us warm inwinter.

April
Chapter 5 Acids, Bases and Salts

Acids and Bases

Natural indicators aroundus
Litmus: A naturaldye
Turmeric is another natural indicator
China Rose asIndicator
Neutralisation

Neutralisation in everydaylife-
Indigestion

Antbite

Soil treatment

Factory wastes

temperature by Lab
Thermometer

e Transfer of heat by the
method of Conduction
andConvection

e Video: Sea Breeze and
LandBreeze

Activity:
¢ |dentification of the
acidic/basic/neutral
nature of salt solution
e Reaction between acid
and base to show the
process of neutralisation

NCERTBook
NCERT Exemplar Exercise

e Oralquestioning.
e Discussion of

NCERTBook
/ NCERT Exemplar
Exercise

o KeyQuestions
Diagrams Assignment

e KeyTerms
e KeyQuestions
e Assignment




Chapter 13 Motion and Time
e Slow or fast, Speed
Measurement of time
Units of time and speed
Measuring speed
Distance TimeGraph

Activity:
e Calculation of Time period of simple
pendulum

e Oralquestioning.

e Discussion of NCERT
Book / NCERT Exemplar
Exercise

Month Project/Activity Oral Work Written Work
Content/Theme
August
Chapter-10 Respiration in Organisms Activity: e Oral questioning. e KeyTerms
e Why do we respire e Understand the mechanism of breathing | ¢  Discussion of NCERT e KeyQuestions
e Breathing - How do we breathe Video: Book / NCERT Exemplar e Diagrams
e What do we breathe out? e Respiration in humans Exercise e Assignment
e Breathing in other animals e Respiration in other organisms
e Breathing underwater
e Do plants also respire
July
Chapter 6 Physical and Chemical Change |Activity:
e Physical changes e Demonstration based on Physical e Oral questioning. * EeyTermsi
e Chemical changes Change « Discussion of NCERTBook | . eytuestions
e Rusting of iron e Demonstration based on Chemical / NCERT Exemplar Exercise | Assignment
e Crystallization Change
e Burning of Magnesium ribbon
e Change in colour of copper
sulphate solution
August

KeyTerms
KeyQuestions
Diagrams
Plotting

of

graphs
Assignment




Month Project/Activity Oral Work Written Work
Content/Theme
July Video: e Oral questioning. |e KeyTerms

Chapter 7 Weather, Climate and Adaptation of animals to
Climate

e Weather

Climate

Climate and adaptation
The polar regions

The tropical rain forests

e Adaptation by animals in
polar region and in
Tropical rainforests

e Discussion of

NCERT Book /
NCERT Exemplar
Exercise

e KeyQuestions
e Assignment

July-August

Chapter 8 Wind, Storm and Cyclones
e Air exerts pressure

High speed winds are accompanied by reduced air pressure
Air expands on heating
Wind current generates due to uneven heating onearth
Uneven heating between the equator and the poles
Uneven heating of land and water
Thunderstorms and cyclones
Destruction caused by cyclones
Effective safety measures
Advanced technology has helped

TERM 1 CHAPTERS: 1,2,4,5,6,7,8,10,13

Activity:

e Observe that air exerts
pressure

e Observe that air expands
on heating

Video:

e Formation of
Thunderstorms and
Cyclone

e Oralquestioning.
e Discussion of

NCERT Book /
NCERT Exemplar
Exercise

e KeyTerms
e KeyQuestions
e Assignment




Month Project/Activity Oral Work Written Work
Content/Theme

September

Chapter 3 Fibre to Fabric PERIODIC TEST - 2(CHAPTERS-3,9,11,14)

> Animal fibres - Wool,Silk . e Oral Questions o KeyTerms

> Animals that yieldwool Activity: o e Discussion of e KeyQuestions

> From fibres towool ~» Based on wool yielding animals NCERT Book e Diagrams

> Processing fibres intowool Video: INCERT e Assignment

[

Silk, Life history of silk moth, from cocoon to
silk

e Processing ofwool
e Life Cycle of silkmoth
e Processing of silk

ExemplarExercise

October
Chapter 11 Transportation in Animals and plants

Circulatory system

Blood, Bloodvessels
Heart,Heartbeat

Excretion inanimals

Transport of substance inplants
Transport of water and mineral
Transpiration

October
Chapter 9 Soil

Soil teeming withlife
Soilprofile

Soiltypes

Properties ofsoil

Moisture in soil
Absorption of water by soil
Soil and crops

Activity:

e Based on classification of bloodgroup
e Use of stethoscope

Video:

e Working of human heart

e Excretion inAnimals

e Transportation in plants

Activity:

e Percolation rate of water insoil
e Absorption of water by soil
Video:

Formation ofsoil

Soil profile

Oralquestioning.
Discussion of
NCERT Book /
NCERT Exemplar
Exercise

Oral questioning.

Discussion of NCERT
Book / NCERT
Exemplar Exercise

o KeyTerms

o KeyQuestions
e Diagrams

e Assignment

e KeyTerms

e KeyQuestions

e Diagrams
Assignment




November
Chapter 14 Electric Current and its Effects
e Symbols of electrical components
e Heating effect of electric current
e Magnetic effect of electric current
Electromagnet, Electricbell

4 November
Chapter-12 Reproduction in Plants
e Modes of reproduction
e Asexual reproduction
o Vegetative propagation
o Budding
o Fragmentation
o Sporeformation
e Sexual reproduction
e Fruits and seed formation
Seed dispersal

Activity:
e Electric Circuit
e Heating effect of current
e Magnetic effect of current
e Electric bell
e Demonstrate MCB and types of fuses

Activity:

e |dentify parts of flower and
distinguish between unisexual and
bisexualflower

e Bryophyllum leaf

Video:

e Asexual reproduction in plants
Sexual reproduction in plants

e Oral questioning.
Discussion of NCERT
Book / NCERT
Exemplar Exercise

e Oral questioning.
Discussion of
NCERT Book /
NCERT Exemplar
Exercise

KeyTerms
KeyQuestions
Diagrams
Assignment

KeyTerms
KeyQuestions
Diagrams
Assignment




Month Project/Activity Oral Work Written Work
Content/Theme
1 December Activity: e Oralquestioning. e KeyTerms
Chapter 15 Light o e Formation of image by spherical mirror | e  Discussion of o KeyQuestions
* Lighttravels along a straight line e Formation of image by lens NCERT Book / e Diagrams
* Reflection of _I'ght ) e Dispersion of light using prism NCERT Exemplar e Assignment
e Image formation by plane mirror Exercise
e Spherical mirrors
e Images formed by lenses
¢ Sunlight- White or Coloured
Chapter 16 Water: A Precious Resource
e How much water isavailable \ideo: e Oralquestioning. e KeyTerms
Forms of water . G-roun dwater e ClassDiscussion e KeyQuestions
Ground water as an important source ofwater e Discussion of e Diagrams
Depletion of watertable NCERT Book / e Assignment

Distribution ofwater

What role you canplay
Watermanagement

Effect of water scarcity on plants

NCERT Exemplar
Exercise




Chapter 17 Forests: Our Lifeline
e Visit to forest, Interdependence of plants
and animals in forests
e Importance of forests
e Components of forests

Chapter 18 Waste Water Story
e Water ourlifeline
e What issewage
e Water freshens up- An eventfuljourney
e \Wastewater treatmentplant
e Better housekeepingpractices

ANNUAL EXAM CHAPTERS:
3,4,6,9,11,12,14,15,16

e Structure of forest

Video
e Working of Waste water treatmentplant

e ClassDiscussion

e Discussion of
NCERT Book /
NCERT Exemplar
Exercise

¢ Oralquestioning.

e ClassDiscussion

e Discussion of
NCERT Book/
NCERT Exemplar
Exercise

Month Project/Activity Oral Work Written Work
Content/Theme
JANUARY Video: e Oral questioning. |e KeyTerms

e Key Questions
e Assignment

e KeyTerms
e Key Questions
e Assignment

FEBRUARY

REVISION FOR ANNUAL EXAMINATION

MARCH

ANNUAL EXAMINATION




Examination Schedule & Syllabus ENGLISH
(Session: 2023-2024)

SUBJECT PERIODIC TEST HALF YEARLY EXAM PERIODIC TEST 2 ANNUAL EXAMINATION
40 MARKS 80 marks 40 marks 80 marks
6 JULY 2019 17 September Literature Literature
Literature Poem Literature @ The Expert
. = Ashes that made the Detectives *A Bicycle in good repair
" The Squirrel trees bloom. B The invention of
" The Rebel = Gopal and Hilsa Vita Wonk The Expert Detectives
Prose Fish Poem
" The Three * The three Meadow Surprises The invention of Vita Wonk
Questions questions
* The Gift of = The gift of chappals Grammar Gopal & Hilsa Fish
Chappals Poem Tenses
d Grammar The Shed Direct and Indirect
= Verbs . Poem
= Tenses The Squirrel Speech Garden Snake
(Present, The Rebel Composition Meadow Surprises
Past & v Grammar . Letter to the Editor The Shed
= Active and Passive e
Future) voice Paragraph Writing Grammar
. = Verbs Tenses
2 Co:"'Np;-i“C'Z'O“ = Tenses Novel Direct and Indirect Speech
= Diary Entry " Adverbs and Book Review (each Pronouns
. Arti r degrees of tudent has a Adjectives & Degrees of
rticle Writing ) S Comparison
4 Novel comparison separate book)

= Book Review
(each student
has a separate
book)

J{ Composition
= Complaint letter
= Article
= Story

{ Novel
Book Review (each student has a
separate book)

Novel
Book Review
(each student has a
separate book)




Prescribed books-

Book 1 — Honeysuckle (Literature)

Book 3 - Cordova Grammar and Composition Skills -7

Curriculum Plan of English
(Session: 2023-2024)

Book 2 — Book Review (individual story books)

[ Dramatizatio
non
characters of
the chapter.

Month Vocabulary/ Listening Skills Speaking Skills/ | Reading Skills | Writing Skills
Content/Theme Grammar Art Integration
1 April % Book3: » Dictation 1 Discussion = Reading for |= Diary Entry
% Book 1:Literature Grammar = Speech about doing detail = Notice
L-1 The Three Questions » Verbs recognition — to good to
» Present correct factual/ others = Poem
Poem Tense textual errors Self- Recitation
The Squirrel introspection




Month Vocabulary/ Listening Skills Speaking Skills | Reading Skills | Writing Skills
Content/Theme Grammar
1 June % Book 3:Grammar | = Dictation » Speech » Extended = Article
% Book 1:(Literature) » Tenses- » Sharing an CGroup reading
Past & experience of their activity of » Reading for
L-2 The Gift of Chappals Future visit to an sharing their appreciation
Poem — The Rebel orphanage experience (poem)
of helping a
needy
person
4 July % Book 3:Grammar | = Dictation = Narration of » Interactive = Situational
% Book 1:Literature = Active and comic Reading Story
Gopal and the hilsa fish Passive stories. = Scanning
Poem — The Shed voice = Singingsong | = Reading for
on unity Appreciation
o (poem)

liuLy

PERIODIC TEST -1




Month Vocabulary/ Listening Skills Speaking Skills | Reading Skills Writing
Content/Theme Grammar Skills
4 August % Book 3:Grammar |= Dictation = Group discussion| = Dramatised reading |= Complaint
% Book 1:Literature Adverbs & » Narration of a on There is » Reading for detail Letter
Degrees of Japanese Tale sufficiency in the

The Ashes that comparison world for man’s

made the trees need, not for

bloom man’s greed.”

» Asking students
on how many
famous
personalities
come forward to
help the needy.

J September

s Book 1
o Poem-
Meadow
Surprises

REVISION FOR HALF YEARLY

EXAMINATION

Poem Recitation




Role play

Month Vocabulary/ Grammar | Listening Skills | Speaking Skills | Reading Skills | Writing
Content/Theme Skills
{ October % Book 3:Grammar » Dictation Narration of = Newspaper » Placing
« Book 1:Literature Conjunctions » Mock interview detective stories. | reading an
The Expert Detectives » Reading for Order
appreciation
4 November % Book 3:Grammar = Dictation Children to share| = Extended » Formal
% Book 1:Literature = Directand = Audio clip - about home reading letter
Indirect Speech speech of remedies for » Reading for
The Invention of Vita Wonk famous common ailment.| detail
scientist




Month Content/Theme Vocabulary/ Grammar Listening Skills Speaking Skills | Reading Skills | Writing Skills
J December
+« Book 1:Literature PERIODIC TEST -2
% Book 3:Grammar = Interaction Children to » Extended = Bio-sketch
Poem-Garden Snake = Prepositions about share about reading
different their phobia
phobia and how they
dealt with it.
J January % Book 3:Grammar = Dictation » Talk time- = Dramatised = Story
% Book 1:Literature Articles » Listeningtext Just a reading
minute

A Bicycle in good repair

C Conversation
between a cycle
owner & a
mechanic

JFebruary

REVISION FOR ANNUAL EXAMINATION

IMarch

ANNUAL EXAMINATION
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Curriculum Plan of Social Science

(Session: 20229-2023)

ANNUAL CURRICULUM PLAN
CLASS-VII

SESSION:2023-24

Computer Science

Examination Schedule & Syllabus
(Session: 2023-2024)



Computer
Science

Term-1

7 September 2022

J Flowchart
d algorithm
J Conversion

e Binary to decimal

e Decimal to Binary
4 More on windows
4 More on e-mail

Term-2

2 March 2023
4 MWword
1 MS Excel
4 MS Publisher




Curriculum Plan of Computer Science
(Session: 2023-2024)

Month Theory Activities Practical /Project
April -
Introduction » Computer system > Recognition and classify > Prepare the list of
To Computers | » Hardware the computer hardware hardware and
> Software and software part software and type
> Relationship between hardware & software > Mention the type and use itin ms word
> Data hierarchy of various hardware and
> Trouble shooting tips software

> Discuss the relationship
between hardware and
software

> Explain the hierarchy of
data

> Detect the problemin the
computer system

> Concept of Trouble
Shooting

>
May Vacation




June > Introduction > Open Window Explorer
More OnMS | > Open windows explorer » Explorer Windows Library
Windows 7 > Libraries in ms windows > Change The View Of File
> Changing virus of folders and file large view extra Folder
large small medium list detail title content > Organize File And Folder In
> Creating shortcut on desktop Windows Explorer
> Organising files and folder in windows explorer > Create Shortcut Of File
> Opening creating renaming selecting deleting Folder
moving copying viewing property > Group File Folders In
> Grouping files and folders Different Ways
> Onscreen keyboard > Use On Screen Keyboard
> Cdburning > Burn CD DVD
Month Theory Activities Practical /Project
July -
August » Introduction » Basic concept of » Lab -Q basic program
(I\?A_%fsfcn > Difference statement and programming * Adding two numbers

commands in q basic
» Control statement

Y

If else statement
> Graphicsin q basic
e Line

e C(Circle

> Control statement let,
input, print, cls etc

> Other statement
o if-then-else,
e if-end..if etc

> Change case

e Product of two numbers
e Area/ perimeter of rectangle
, Triangle and square
e Conversion
o Rupees- Paise
o KGt-mg
o Meter-cm




e Greater number among two
nos & three nos.

e Smaller number among two
nos & three nos.

e Entering marks and
calculating percentage &
grade -Mark sheet

e Average of 4 nos.

> Lab -Q basic program
e Drawingline
e Drawingcircle

September

Lab- Practical — Revision of all topics & Practical exam for Term-1

HALF YEARLY
EXAMINATION




Month Theory Activities Practical /Project
October
Computer > Introduction > Define computer virus > Find out the antivirus
Virus > Computer virus > List the ham and symptoms software in lab
> Harm caused by computer virus of computer virus > Scan the pen drive and pc
> How do you get a computer virus > List the ways in which a and see the result on screen
> History of computer virus virus attack computer (status of virus or / and
> Type of computer virus > Know the history of cleaning of files / folder)
> Protecting your computer computer virus
> Antivirus > Types of computer virus
e Using anti-virus software > Learn how to protect the
e Scanning your computer computer from virus
e Scanning external device > Scan the computer and
e Updating antivirus software external device using anti-
virus
> Update the anti-virus
November
More On > Introduction > History of internet > Lab- Searching information
Internet > Impact Of Internet on "Save earth -Save Water"

> Online Education
e Searching Information
e Finding People
e Searching Informative Videos

> Impact on society good or
bad

» Online education and its
concept

> Searching information

> Lab -Download the images of
Chandrayan-2




Using A Tablet
e E- Greeting Cards
e Downloading

through search engine
> Finding people and chatting
> Searching and downloading

e Chatting images videos and audios
December
Mgr% OnI > Revision of MS Excel data sheet, | » Define cell referencing » Create worksheet and write
2007 Xce cell ,cell address _ > Define relative, absolute and formula to calculate total marks
Formulae > Data entry and formatting mixed referencing and percentage highest, lowest
And > TextFormula > Using different function in ms marks and grade
Function > Types Of Cell Referencing & &

>

Using Function

e Sum, Average, Count, Max, Min,

If
> Conditional Formatting
> Sorting Data
> Filtering Data
e Custom Filter

excel(sum, average, count
number, max, min and if)

> Applying conditional
formatting

> Define sorting and filtering of

data

> Apply filter and custom auto
filter on a range

> Define sorting and sort the
data

> Perform various operations on
cell (overwrite, modify,
delete, cut, copy, paste)

> Insert & delete cells and rows/
columns

> Adjust row and column width

> Enter a predefined series of
data using auto fill

> Create custom list using auto

> Create bill of purchasing books,
discount and final amount using
formula




fill.
January
Charts In > Introduction > Define chart and mentionits | > Lab-
g/IO%?EXCEI » Component Of A Chart advantage e Create Pie, Bar, Donut Chart
> Types Of Chart In MS Excel 2007 > |dentify the component of a For Giving Given Output
> Creating Chart chart e Create A Bar Chart For All
e Changing The Chart Type > Identify and define different Subject Marks Of Student
e Changing The Chart Style types of chart e Create Pie Chart To Area And
» Changing Data In Text In A Chart > Create chart in ms excel 2007 Gases
> Deleting Data And Text In A Chart » Change the chart type, chart
> Resizing And Moving Charge Chart style
> Printing Charts > Change / delete text and data
in a chart
> Resize and move a chart
February Lab Practice For Ms Excel -formulae and charts and Practical Annual Examination
March ANNUAL EXAMINATION-

Written
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Books prescribed:

1. Our Pasts—II- (History)

2.0ur Environment (Geo)

3. Social and Political Life —I1 (Civics)

Month Curriculum plan of Social Studies (20222-2023) ten Work

Content/Theme

April Literary sources and Discussion on New | 1) Question Answers and bookwork
J Our Pasts -1 Archaeological social and political | 2) Timeline on Medieval Period

Chapter-1 Tracing Changes Through A
Thousand Years

1) New and Old Terminologies

2) Historians and their Sources

3) New Social and Political Groups

4) Region and Empire

5) Old and New Religions

6) Thinking about Time and Historical Period
Chapter-2 New Kings and Kingdoms

1) The emergence of new dynasties

2) Administration in the Kingdoms

3) Prashastis and land grants

4)Warfare for wealth

5) A closer look- The Cholas

4 Our Environment

Chapter-1Environment
1) Natural Environment
2) Human Environment

sources of medieval
period.

Map marking on
chola kingdoms.

Video on components
of environment.

groups of medieval
India.

Discussion about
the famous rulers
of North and South
India.

Discussion on
environmental
problems.

in India.

1) Question Answers and bookwork

2) Map Activity on the extent of major
Indian kingdoms of early medieval
period.

3) Timeline of dynasties of
Medieval Time.

1) Question Answers and bookwork
2) Flowchart on components
of Environment.







Month Project/ Activity Oral Work Written Work
Content/Theme
June Fundamental Rights Debate on the issue 1) Question Answers

{4 Social and Political Life-I1
» Chapter 1- On Equality
1) Equal Right to vote
2) Other kinds of equality
3) Recognizing dignity
4) Issues of equality in other democracies
5) Challenge of Democracy

‘Indian Democracy is
a boon to Indian
Society’

June
4 Our Environment
= Chapter 2-Inside Our Earth
1) Interior of the Earth
2) Rocks and Minerals

PERIODIC TEST -1

1) Video on the formation
of rocks

2) Video on layers of
the earth

Discussion about
formation of rocks

1) Question Answers

2) Flow chart on layers of the
earth

3) Diagram on Rock Cycle

July
{ Social and PoliticalLife-11
» Chapter 2 Role of the Government in
Health
1) What is Health?
2) Healthcare in India
3) Public and private health care services
4) Public health services
5) Private health services
6) Healthcare and equality: Is adequate
healthcare available to all?
7) What can be done?
8) The Kerala experience
9) The Costa Rican approach

Video on Public
Healthcare and Private
Healthcare facilities

Debate on Public
Healthcare and Private
Healthcare facilities

1) Question Answers




Month Project/ Activity Oral Work Written Work
Content/Theme
July Video on Working of Discussion on 1) Question Answers

{4 Social and Political Life-I1
= Chapter-3 How the State Government Works
1) A debate in the Legislative Assembly
2) Working of the Government
3) A wall paper project
d Our Pasts —II
= Chapter-3 The Delhi Sultans
1) Finding out about the Delhi Sultans
2) From garrison town to empire- the expansion of
the Delhi Sultanate
3) A closer look: Administration and
Consolidation under the Khaljis and Tughlugs
4) The Sultanate in the fifteenth and
sixteenth centuries
4 Our Environment
= Chapter-3 Our ChangingEarth
1) Major land forms
2) Work of a river
3) Work of sea waves
3) Work ofice
4) Work ofwind

State Government

Video on the rulers of
Delhi Sultanate

Role play on Raziya
sultan, Allauddin Khalji
and Tughluq’s

Video on the endogenic
and exogenic forces of
the earth

Earthquake skit( how
much its effect with its
measurements)

Unicameral and
Bicameral States
of India

Discussion on
the comparison
of Delhi Sultans
from early
Muslim invaders

Discussion
about the work
of different land
forms

2) Flow chart on the Institution of

State Government

1) Question Answers and
book work

2) Timeline about the rulers

of Delhi

1) Question Answers

2) Flow chart on evolution of

landforms
3) Diagram on origin of an
earthquake.

August
J Our Pasts —II
= Chapter-4 The Mughal Empire
1) Who were the Mughals?
2) Mughal Military Campaigns
3) Mughal Traditions of Succession
4) Mughal Relations with other rulers

1) Collage of the
constructions during
the reign of Shah
Jahan

2) Video on Early
Mughals and Later

Mughals

Discussion
about Six great
early Mughals

1) Question Answers

2) Timeline about the rulers

of Mughal Empire

3) Map Activity on Military
Campaign by Mughal Rulers




Month Project/ Activity Oral Work Written Work
Content/Theme

August 1) Video on three types Discussion on current 1) Question

4 Our Environment of rainfall status of Global Answers

» Chapter-4Air
1) Composition of the Atmosphere
2) Structure of the Atmosphere
3) Weather and Climate

{ Social and Political Life-11
= Chapter-4 Growing up as Boys and Girls
1) Growing up in Samoa in the1920s

2) Growing up male in Madhya Pradesh in the1960s

3) Valuing housework
4) Lives of domestic workers
5) Women’s work and equality

4 Our Pasts -II
= Chapter-5 Rulers and Buildings
1) Engineering Skills and Construction
2) Buildings Temples, Mosques and Tanks
3) Why were temples destroyed?
4) Gardens, Tombs and Forts
Region and Empire

2) Make a weather calendar
for one week

Video on women’s equality

Video on constructions of
buildings by Mughal
Emperors

Warming

Discussion about
Gender discrimination

Discussion on
Architectural styles of
Mughal rulers

2) Diagram on
Layers of
Atmosphere

Question Answers

September
4 Social and Political Life-I1
= Chapter-5 Women Change the World

1) Fewer opportunities and rigid expectations
2) Learning for change
3) Schooling and education today
4) Women’s movement
5) Campaigning
6) Showing Solidarity

HALF YEARLY EXAMINAITON

Video on Women
empowerment

Discussion about
women’s role in today’s
world

1) Question Answers




Month Project/ Activity Oral Work Written Work
Content/Theme

September Video on Traders Discussion about 1) Question Answers and
4 Our Pasts -II and Crafts persons Hampi, Masulipatnam book work

Chapter-6 Towns, Traders and Crafts persons
1) Administrative Centre’s

2) Temples, towns and Pilgrimage Centres

3) A Network of Small Towns

4) Traders Big and Small

5) Crafts in Towns

6) A Closer Look: Hampi, Masulipatnam and Surat
7) A Gateway in the West: Surat

8) Fishing in Troubled Waters: Masulipatnam

9) New Towns and Traders

of Medieval India

and Surat

2) Map Activity on centres of
trade in central and south
India

October
4 Our Environment

Chapter -5Water

1) Distribution of Water Bodies

2) Ocean Circulation

3) Ocean Currents

Ch-6 Natural Vegetation and Wildlife
1) Forests

2) Grasslands

d Social and Political Life-11

Chapter-6 Understanding Media
1) Media and technology

2) Media and money

3) Media and democracy

4) Setting agendas

1) Video on
formation of
spring tide and
neap tide

Video on natural
vegetation and
wildlife

Video on role of
media in a
democracy

Discussion on the
importance and ways
to conserve fresh
water

Discussion on
importance of Forests
and wildlife

Discussion about
media’s role on a
democracy

1) Question Answers

2) Map work on Ocean currents
and major seas, lakes and
rivers of the world.

3) Diagram of Spring Tide and
Neap Tide

1) Question Answers
2) Flow chart on Types of
Vegetation

1) Question Answers




Month Project/ Activity Oral Work Written Work
Content/Theme
October Video on role of advertising in | Discussion on use

{ Social and Political Life-11
= Chapter 7 Understanding Advertising
1) Building brands and brand values
2) Brand values and social values
3) How does an advertisement get made?
4) Advertising and democracy
4 Our Environment

» Chapter-7 Human Environment-Settlement:

Transport and Communication
1) Roadways

a democracy

1) Video on different modes of
transport and
communication

and misuse of
Advertisements in
Modern Times

Discussion on modes
of transport and
communication

No written work

1) Flow chart on types
of settlement

2) Railways 2) Project work on the effect of
3) Waterways transportation on the
4) Airways environment
5) Communication
November ]_) Question
4 Our Pasts -II Video on the life of Nomadic Discussion on Answers and
and Pastoral Groups dominant tribes of book work

» Chapter 7 Tribes, Nomads and Settled

Communities

1) Beyond Big Cities: Tribal Societies

2) Who were Tribal People?

3) How Nomads and Mobile People Lived

4) Changing Society: New Castes and
Hierarchies

5) A Closer Look: The Gonds and the Ahoms

6) Conclusion

north-east India and
the regions they
occupy

2) Map work on the
tribes of north-east
India




Month
Content/Theme

Project/ Activity

Oral Work

Written Work

November
{4 Social and Political Life-I1
= Chapter 8 Market Around Us
1) Weekly market
2) Shops in the neighbourhood
3) Shopping complexes and malls
4) Chain of markets
5) Markets everywhere
6) Markets and equality
J Our Pasts -II
» Ch-8 Devotional Paths to the Divine
1) The Idea of a Supreme God
2) A New Kind of Bhakti in South India-
Nayanars and Alvars
3) Philosophy and Bhakti
4) Basavanna’s Virashaivism
5) The Saints of Maharashtra
6) Nathpanthis, Siddhas andY ogis
7) Islam and Sufism
8) The Religious Development in North India
9) A Closer Look: Kabir
10) A Closer Look: Baba Guru Nanak Dev
4 Our Environment
* Ch-8 Human Environment Interactions:-
The Tropical and the Subtropical Region
1) Life in the Amazon basin
2) Climate
3) Rainforests
4) People of the Rainforests
5) Life in the Ganga- Brahmaputra Basin

Video on different kinds of
markets

Video on Bhakti and Sufi
Traditions in India

Video on tropical and sub-
tropical region of the world

Discussion on role of
different kinds of
markets

Discussion on Bhakti
and Sufi movements in
Medieval India

Group Discussion on-
“Deforestation — A
Growing Concern”

1) Question Answers
2) Flow chart on types
of markets

1) Question Answers
2) Timeline on Popular
Bhakti and Sufi

movements

1) Question Answers

2) Map work on
Ganga
Brahmaputra basin
and Amazon basin




Month Content/Theme Project/ Activity Oral Work Written Work

December
1 our Pasts -I1 PERIODIZC TEST -
» Ch-9 The Making of Regional Cultures - . - - .
1) The Chera and the Development of Malayalam E/I;iz?cglnddalr]:zrigtms of \I/Da:?i%uussSIc(:gsgincal aNc?ia;JeStlon Answers oty
2) Rulers and Religious Traditions: The Jagannatha Cult India dance forms of y
3) The Rajputs and Traditions of Heroism India

4) Beyond Regional Frontiers: The Story of kathak .
5) Paintings for Patrons: The e Students will perform
Tradition of Miniatures different dance form.
6) A Closer Look: Bengal
7) Pairs and Temples
8) Fish as food

{ Social and Political Life-11

» Ch-9 AShirtin the Market 1) Video on the story Discussion Question Answers
1) A cotton farmer in Kurnool of a shirt i
_ about chain of
2)The cloth market of Erode 2) Collage on different markets
3) The garment exporting factory near Delhi kinds of textiles
4) The shirt in the United States available in the
5) Who are the gainers in the market? Indian Market
6) Market and equality
January Video on emergence of Discussion on 1) Question Answers
J Our Pasts -II new states in medieval famous 2) Map Activity on
» Ch-10 Eighteenth Century Political Formations period buildings and British Territories in the
1) The Crisis of the Empire and Later Mughals monuments of mid eighteenth century
2) Emergence of New States Asaf Jah

3) The Old Mughal Provinces
4) The Watan Jagirs of the Rajputs
5) Seizing Independence




Month Project/ Activity Oral Work Written Work
Content/Theme
January Video on the Prairie | Discussion on the 1) Question Answers and bookwork
4 Our Environment and the Veld interesting facts of the | 2) Map Activity on the location of
»= Ch-9 Life in Temperate Grasslands Grasslands Prairies and the Velds The Prairies and the Velds

1) The Prairies
2) Climate
3) Flora and Fauna
4) People
5) The Velds
6) Climate
7) Floraand Fauna
8) People
»= Ch-10 Life in the Deserts
1) The Hot Desert-Sahara
2) The Cold Desert- Ladakh

4 Social and Political ~ Life-II
= Ch-10 Struggles for Equality
1) Struggles for equality
2) Tawa MatsyaSangh
3) The Indian Constitution as a
living document

Video on Sahara and
Ladakh Desert

Video on different
kinds of struggles for
equality

Grasslands

Discussion about the
festivals of Ladakh
Desert and tribes of
Sahara Desert

Discussion on value of
equality in Indian
Democracy

Grasslands

1) Question Answers and bookwork
2) Map Activity on the location of
Sahara and Ladakh Desert

Question Answers

February

Revision for Annual Examination

March

Annual Examination
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